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Penpower Technology Ltd. 

Software User License Agreement
You are licensed to legally use this software program (“the Software”) by Penpower 

Technology Ltd (“Penpower”) under this license agreement (“The Agreement”). If you do 
not agree with any of the provisions in this Agreement, please do not install, copy or use the 
Software. By using the Software, you are deemed to fully understand and accept the provi-
sions of this Agreement.

1.  Intellectual Property
All intellectual property rights in the Software, together with all information and docu-
ments included in the packaging for the Software (including but not limited to copy-
rights), are property of Penpower, and are protected by relevant laws and regulations.

2.  License to Use
You are authorized to use the Software on one (1) single computer only. You may not use 
the Software on any other machines other than the said single computer.

3.  Authority to Copy
The Software and all documents included with the Software, and copyright thereof, are 
property of Penpower. You are licensed to make one (1) copy of the Software for your 
personal backup purposes. All other acts of copying are strictly prohibited.

You may not sell, lease, dissemble, reverse engineer, copy, translate, adapt or derive the 
Software, or obtain the source code of the Software by any other means. You may not use 
the Software for any purposes other than those permitted under this Agreement.

4.  Business Users
If you need to install or use the Software on more than one (1) computer, please contact 
Penpower or our local distributor to purchase a license for the additional use.

5.  Liability
You agree to indemnify Penpower against all losses, costs, debts, settlement payments or 
other expenses (including but not limited to attorneys fees) arising from your breach of 
this Agreement, and you agree to compensate Penpower for all of the abovementioned 
damages.

6.  No Warranty
Effectiveness of a packaged software in handling information is closely related to its soft-
ware and hardware environment. The Software is published following careful develop-
ment and product testing by Penpower, but Penpower is not able to conduct tests based on 
all possible combinations of software and hardware environment. Therefore, Penpower is 
unable to promise nor warrant that there will be absolutely no risk of loss or damage of 



information, or any other kind of loss, during installation and/or execution of the Soft-
ware. You must be fully aware of your risks in using the Software.

Penpower will provide you with the Software and support services in respect of the Soft-
ware to the maximum extent permitted by law. However, Penpower does not warrant that 
the Software and information included in the package of the Software contain no defects 
or errors. Penpower is not liable for any indirect, special or incidental loss arising from 
the Software, including but not limited to loss of profits, damage to business reputation, 
cessation of work, hardware malfunction or damage, or any other commercial damage or 
loss arising from commercial use of the Software.

7.  Limitation of Liability and Damages
The maximum amount of compensation payable by Penpower, in respect of any damage 
incurred by you for any reason under this Agreement, is limited to the amount you have 
already paid to Penpower in respect of the Software.

Under no circumstances will Penpower be held liable for the possibility of loss, notwith-
standing Penpower may be aware of the possibility of such loss.

8.  Prohibition Against Sublicense
You are prohibited to assign the license in respect of the Software granted to you under 
this Agreement, or to grant a sublicense to another person.

9.  Jurisdiction
With regards to any disputes arising from this Agreement, Penpower and you agree that 
the court having jurisdiction over the business location of Penpower will be the court in 
the first instance.

10. Miscellaneous
In the event that any provision of this Agreement is found to be invalid at law, such 
invalidity will not affect the validity of any other provisions, or the legal enforceability of 
such other provisions.

In the event that the Software cannot be executed under conditions of normal use, due to 
any damage to the original disk/s, Penpower will replace the disk/s free of charge.
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Chapter 1 Product Introduction 1-1

Chapter 1 Product Introduction

Penpower WorldCard provides a total business card management solution by integrating 
card recognition, management, and printing functions in a single digitizing unit to find your 
business cards at any given time.

1.1 WorldocScan Pro Scanner
WorldocScan Pro Scanner is a cordless scanner, allowing you to scan anywhere. No 

computer connection is needed to scan. Simply charge it up and then insert your document 
to scan.

8 Front   Status Light

8 Back 

8 Side

Paper output 

Power button

mini USB Port for data transfer and charge                   
(charged only by USB cable)

Paper feed slot                              
(feed on left and face up)

USB host                   
(flash disk)

Memory card slot
(MS/MS Pro/MMC/xD/SD)



1-2 WorldCard

Tips

• Paper Feed Slot: Insert a card with the information side facing up and make sure the 
card placed against to the left-hand side.

• Status Light: Scanner scans at two resolution modes: 300dpi (default; status light 
white) and 600dpi (status light blue). 

• Power button: Click lightly to boot, and then click to switch between 300/600 dpi. 
Long press to shutdown.

• mini USB Port : Scanner has built-in battery, which needs to charge up before using 
the scanner for the first time and is charged over USB and takes around 2.5 hours to 
fully charged.

Specification

• Dimensions: Optical Resolution: 300 x 300 dpi (defaul); 600 x 600 dpi
• Scan Modes: Color, 24 bits (R/G/B)
• Scanner size(D x W x H): 58 x 269.3 x 47.2mm
• Scanner weight(approximately): 425.5g
• Page Size:  up to 8.5” x 12”
• Memory card slot: MS / MS Pro / MMC / xD / SD
• File format: JPEG
• Internal flash memory: 512 MB
• Operating Temperature: 15 ~ 35°C
• Operating Relative Humidity:  20%~70% RH
• Storage Temperature:  -20°C~60°C
• Storage Relative Humidity:  10%~90% RH 
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1.2 Product Feature
•  Easy Card Reader

Scanning or capturing your business cards has never been quicker or easier.

•  Organize Business Cards
After scanning or capturing your business cards, WorldCard software can organize, sort, 
search, add and delete any entries. Also, you can easily edit and add notes to any business 
card.

•  Advanced Search
Full text search to find your contacts easily and conveniently.

•  Support multiple languages
Recognize business cards in different languages, including English, French, German, 
Italian, Dutch, Swedish, Norwegian, Danish, Finnish, Russian, Polish, Turkish, Hungarian, 
Spanish(Spain and Mexico) Portuguese(Portugal and Brazil), Greek, Czech, Slovak, 
Traditional Chinese, Simplified Chinese, Japanese, Korean and many more to come.

•  Multiple Categories and Sub-Categories
Organize card information into categories and sub-categories in any way you want.

•  Print Templates
WorldCard provides various print templates. You can also easily create your own tem-
plates and print contact information in different formats.

•  Recognize Contacts from Other Sources
Recognize business card image files taken by digital cameras or advanced mobile phones.
It can also work with the flatbed scanner.

•  Data Exchange
Support synchronization/importing/exporting for Outlook, Outlook Express, Lotus 
Notes, Palm, Windows Mobile, ACT! by Sage, Goldmine, Salesforce, PIM software, and 
WorldCard series, such as WorldCard Mac, or WorldCard Mobile versions (WorldCard 
Mobile and WorldCard Contacs).

•  Unicode
Unicode makes it possible to display various languages of business cards at the same time.
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1.3 Scan with Scanner
1.3.1 Scan Directly and Offline

 WorldocScan Pro Scanner is a cordless scanner, allowing you to scan anywhere. No 
computer connection is needed to scan. Simply charge it up and then insert your card to scan. 
The scanner scans the card and save the image into the inner flash immediately. 

Note: Please disconnect the scanner to your PC when you scan the business cards. 

1. Insert the memory card or connect the USB flash drive if you need it.  

2. Turn on the scanner power. When the scanner is ready, the status light will stop blinks.

3. Press the power button to select a scanning resolution mode of 300dpi(White) or 
600dpi(Blue).  

4. Insert your card in face up, straight, aligned to the left into the Paper Feed Slot.  

5. The scanner will detect, feed and scan the page automatically.  

6. When scanning is completed, the scanned image will be saved to JPG format in either a 
USB flash drive, memory card, or the scanner’s internal memory. 

Note: The scanner will detect and use only one destination to store the scanned document. 
The storage preference is USB flash drive > memory card > scanner’s internal 
memory. 

1.3.2 Calibrate the Scanner
 Scanner occasionallly needs calibration to perform at its best. If the scans are showing 

lines or black dots, please calibrate your scanner.   

Please turn on the scanner and insert the calibration sheet (provided by Penpower) to start 
automatic calibration.

1.3.3 Save contacts to WorldCard
Connect the scanner to your PC and load scanned image and recognize them. Refer to 

Chapter 2.3 for more detailed explanation.
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Chapter 2 Getting Started

 Please follow the steps to add new contacts in WorldCard from your scanner.

1. Scan your business cards with the scanner.

2. Launch WorldCard software(if it is not installed, please execute Setup.exe in the CD).

3. Connect the scanner to your PC. 

4. Load scanned image and recognize them.

2.1 Install Software

2.1.1 Software Requirement
• 512MB of RAM

• 500MB of available hard disk space

• Windows 7/Vista /XP

• USB Port

2.1.2 Software Installation
 To start, insert the CD into your CD/DVD ROM (if the installation program does not 

start automatically, please double-click the setup.exe file on the CD).
1. Click Install WorldCard. 

2. Click Next. 
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3. Select I accept the terms of the 
license agreement to accept the license 
agreement. Please read the license 
agreement completely.

4. Please follow the instructions in the on-
screen notice. Click Next to continue. 

5. Please select the location to install the 
program. The default location is c:\
Program Files\WorldCard. Click Next to 
continue. 

Note: It may take a while to install some 
WorldCard components. Please wait.
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2.2 Launch WorldCard
After installation, please launch the WorldCard application by running the application 

software under Start / All Programs /PENPOWER WorldCard / WorldCard.

 System will ask you to register for warranty at your first run. Please click  Register now 
to start registration or click Register later to skip this procedure.  You can register later on 
from Help/Register. If you want to choose Register later and do not need to be reminded 
again, you can check Don’t show this page at startup. If you have already registered, 
please click Registered, skip it. 

6. Click Finish to complete installation. If 
you do not want to restart now, click No, 
I will restart my computer later.

8 Registration
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2. This screen can help you to choose 
Business card language and you can 
change the configure in the item 
“Recognition” of Setting later.

3. The Wizard can help you quickly choose 
what you want to do:

Load and recognize card image in the 
scanner: add new contacts from the 
scanner.

Load card Image: Take an existing 
picture of a business card from Hard 
drives and add it to your file.

Import data: Import data from sources 
such as Lotus Notes, Microsoft Outlook 
and Outlook Express, ACT! by Sage, 
Salesforce, or WorldCard exchange files.

Note: Refer to Chapter 5.9.2 for more 
detailed explanation.

8 Wizard Guide
1. After the WorldCard application starts, 

the following screen will appear.

    The Current business card language will 
appear in the first screen for reference.To 
start the wizard, click Next.
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Notes: The Windows Vista version does not support importing data from Windows 
Contacts, Pocket PC and Goldmine.

Import old version data: Import the previous WorldCard file formats into your new 
WorldCard File. You can select a command and click Finish to continue.

 Tips: 

To batch load business cards images, you 
can select    or  from the 
toolbar. 

2.3 Batch Loading Images from Scanner

2. Choose Yes to “Load & recognize images 
in the scanner” or No to cancel the 
action.

Note: Only the scanned business card 
images will be loaded into your 
WorldocScan and be recognized 
automatically. 

3. If you want to remove the loaded images 
from the scanner, click Yes at this dialog 
box.

Note: If the recognition language isn’t 
correct, your can recognize it again in  
Edit mode. Refer to Chapter 4.3.6 for 
more detailed explanation.

1. Please turn on your scanner and connect it to your PC.

Note: You can see the info “Hardware connected: WorldocScan Pro Scanner” in the 
Scan status pane on the right buttom.
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2.4 Online Help
WorldCard provides excellent online help info:

1. Click Help/Index to find the user manual.

2. Click About WorldCard, you can go to Penpower Technology Ltd. official website at the 
left side to get more information; the hardware information is shown at the right side.  

3. Also you can send e-mail to our customer service contact by pressing Send Email at the 
bottom. You can open your favorite email client, copy and paste hardware information 
and email to us.
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Chapter 3 Overview

3.1 User Interface

A: Category tab
B: Search tab
C: Card Window
D: Recycle bin
E: Add Category

D E F G

A

H J

C
B

I

F: Delete Category
G: Disk space used
H: Status
I:  Alphabet Index
J: Connection status
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3.1.1 Toolbar

A: Save Your Card File                              
B: Print Preview
C: Delete Card                                          
D: Delete Card from Category
E: Settings                                                       
F: View Mode
G: Add New Cards from Scanner

A J K LGFEDCB

H: Synchronize with Outlook/Lotus 
notes/...

I: Send Email
J: Export Your Data to the Selected Flash 

Disk or Hard Drive
K: Edit Card                                             
L: Edit Print Template

When by Display Name is selected, the contacts will be sorted by display name. When by 
Company is selected, the contacts will be sorted by company name. If the display name or 
company name is not English, the contact will be put in the  group.

To choose to sort contacts by Display 
Name or Company, please go to Setting 
on the Tool menu and select Field Setting. 
In the Alphabet Index settings section, you 
can choose by Display Name or Company.

3.1.2 Alphabet Index

H I
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3.2 Viewing Contacts
 WorldCard provides several ways to view your contacts: List Mode, Label Mode, Image 

Mode and Dual Mode. The default setting is List mode. List Mode is the default mode view.
To select a mode, please click View Mode on the View menu  or click the Mode arrow from 
the toolbar.

3.2.1 List Mode View

Contact Information List

After scanning business cards, you will see the scanned contact information list in the right 
pane of the card window.

At the top of the pane, you can quickly see how many cards are in each category. For easy 
organization, the dark-highlighted entries indicate cards that have not been edited or verified yet.

Click the field name to sort the contact information alphabetically, 

Besides the contact information, you can also quickly discriminate the single and

double sided card by their different icons.

Tip: You may select the displayed fields from the Tool menu by choosing Field Setting/
Setting.
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Category tab

You can manage your business cards by storing them into category groups. The Category 
tab is in the left pane of the card window. The All Records category and the Unfiled category 
are the preset categories. WorldCard allows you to add as many user-specified categories and 
sub-categories to manage your business cards as you choose.

3.2.2 Label Mode 

Label Mode  displays contact information and business card at the same time.

The contact information shows display name, company, title, office address, mobile phone 
number , office telephone number , office fax number , Email address and website.

When the  icon appears in the right-top corner, it means the contact has a double-sided 
business card image. You can click the icon to see the other side of business card image.
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3.2.3 Image Mode

Click the  button to view the front sides of all business cards. Click the  
button to view the back side of all business cards.

When the  icon appears in the right-top corner, it means the contact has a double-sided 
business card image. You can click the icon to see the other side of the business card image.
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Tip: Drag the business card image from the view modes (except List Mode) to other ap-
plications such as Microsoft Word, Excel etc.

3.4.5 Hide WorldCard Banner
To hind WorldCard Banner and can extend the management area, please click View/

WorldCard Banner. 

3.2.4 Dual Mode

Dual Mode lists the scanned contact information in the upper right management pane and 
displays the front and back side images of the business card in the lower right pane. You can 
click the front or back side icon of the card to magnify it.

When the  icon appears in the right top corner, it means the contact has double-sided 
business card image. You can click the icon to see the other side of business card image.
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Chapter 4 Edit Cards

4.1 Edit Window Overview

The Edit window allows you to edit the information of individual business cards.

Double-click any card record in the list menu of the management pane or click the Edit 
Selected Record button  on the Edit toolbar to select the Edit window, .

You may click a record and press CTRL or SHIFT key on your keyboard, and then click 
another record for multiple selection.

4.2 Verify Contacts

The Edit window allows you to verify the contact information for any specific business 
card. When the editing window is open for a card, the following screen will be presented 
containing information relevant to the card selected from the Management window.

The Edit window may be used to edit any information on a business card and to correct 
or update information as necessary for future changes of an individual contact. The features 
and functions of this window are described below
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Note: You can double-click on the business card image to see a bigger image or back to 
original view.

Enlarge
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4.3 Edit Contacts

The WorldCard Edit window has three panes: the Card Information pane, the Personal 
Information pane and the Notes pane. The Card Information pane displays all relevant 
business card data retrieving from the card. The Card Information pane is shown in the fol-
lowing picture.

The information in the Card Information pane is categorized in fields such as Name, 
Position, Company, Address, Telephone/Fax numbers, Email address and Web Site. Addi-
tional categories are also available.

The Personal Information pane displays personal information about your contact which 
is not retrieved from your contacts business card.

The Notes pane stores/displays important data from your personal notes about your busi-
ness contacts.

Note: If, at any time during the editing mode, an incorrect action is selected, you can 
reverse the changes by clicking the Restore button  from the Editing window. 
Clicking the Restore Icon  restore the changs of the current content of the busi-
ness card.

To exit the Edit window, right-click the Exit button  or select Exit from the File 
menu of the Edit window toolbar.

Card Information

Personal Information

Notes
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4.3.1 Recognizing Partial Content of a Card Entry
In some cases, the information of a business card may not be completely recognized. You 

may use the Partially Select and Recognize command of the Edit window. To select Par-
tially Select and Recognize, click this icon .

After clicking the Partially Select and Recognize, you can use the mouse to select the 
specific area that contains the correct data.

After selecting the area, select the appropriate field for the information which has been 
highlighted.

Besides, WorldCard allows you partial replacement to the filed you want to replace at the 
left pane directly. Click the field you want to replace, select the area in the name card image, 
then click Replace current field. The replacement will be done.

1

2

3
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4.3.2 Adjusting the Separation Rate
The Separation Rate is the rate of separation between the color of the card background 

and the color of the text data contained on the business card.

After clicking the Separation Rate button , the following window appears.

You can  move the slider to achieve the clearest contrast between the background colors 
of the business card and the text on the card. This adjustment is useful when the business 
card image is blurred, or the contrast between the text and the background of the card is not 
sufficient for correct recognition of the card information.

You may also adjust the separation rate by area. On the top business card image, select 
a specific area, and move the slider to achieve the clearest contrast between the background 
and text of the selected area. You can adjust multiple areas, each area with its own separation 
rate. Click the  button to remove selected area. Click the  button to reverse selected 
area. 
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4.3.3 Reframing Command
The Reframing Manually command al-

lows you to select a specific area of a busi-
ness card to save. After the appropriate area 
is selected, a box will be drawn around the 
selected data.

If the data selected to be modified is cor-
rect, click Yes in the dialog box.

The data outside of the selection box will 
be changed to white.

4.3.4 Fine Rotating

The Fine Rotate command  is 
used to correct the horizontal positioning 
of a card after it has been scanned. This 
is sometimes necessary if a card has been 
inserted into the scanner incorrectly and the 
resulting scan is skewed in the horizontal 
plane. An indication of a card that has been 
improperly scanned is as follows:
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4.3.5 Rotating Card
If the card image shows an incorrect ori-

entation, you can use the Rotate Card com-
mand of the WorldCard editor to properly 
align the card orientation. To use the Rotate 
Card command, click the Rotate Card but-
ton  in the Editor window. After you 
click the button , the rotation angle 
options will appear.

Select the appropriate angle of rotation 
and then click the Rotate button . The 
card image will then rotate to the selected 
orientation. Should you need additional fine 
adjustment of the card image, click the Fine 
Rotate button  required. The rotation angle is selectable

from a pulldown menu.
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4.3.6 Recognizing Again
After adjusting a card image with any 

commands of the Editing window, you can 
recognize the business card again to update 
the image processing of your revised card 
image.

This task can be accomplished by click-
ing the Recognize again icon  from the 
Editing window.

Select the appropriate language(s) for 
the front and/or back side of the card. Then, 
select the correct region for the language. 

You may use the Auto detection feature in the geographic region selection. If the card is 
double-sided, select the Both Sides command to recognize each side. You may then proceed 
with the Recognize again command by clicking the Recognize button . 

After clicking the Recognize icon is selected, the following prompt appears in the Edit-
ing window.

Click Yes to begin the recognition process. Note that the card information will be cleared 
when you click Yes. 

4.3.7 Exchanging Front and Back Side Card Image
Click  to exchange the front side and back side images of the business card.
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4.4 Viewing Cards

Cards are displayed in the Editing window. The following window shows a typical 
display of a card in the Editing window.

You can click Back Side button  to see the back side image of the busi-
ness card.

You can click  to select the different display percentage of the business card 
image.

4.4.1 Saving Card Image
If the displayed card image is clear and the information legible, the card image can be 

saved as a .jpg file by clicking the Save Card Image button . 

4.4.2 Deleting Card Image
To delete a card image from the Editing window, click the Delete Card Image button 
 with your mouse pointer.

If you have made an error in deleting a card image, the Editing window allows you to 
recover the card image by clicking the Restore button .
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Chapter 5 Manage Business Cards

The management functions of WorldCard allow you to categorize contacts, send e-mail 
by contact or group functions, add new cards to a group, import cards from other sources, 
search cards by various data fields, encrypt files to protect your card database, print cards, 
export the database to other applications and synchronize your card information with other 
software applications.

5.1 Categorize Cards
The WorldCard software allows you to manage your business cards by storing them in 

the category groups. After installing your WorldCard software, you will find two default 
categories on the management page: the All Records category and Unfiled category. You 
can add as many user-specified categories and sub-categories as you choose to manage your 
business cards.

Note

WorldCard Mobile and WorldCard Contacts don't support  multi-layer 
category structures. If you export contacts to WorldCard Mobile or 
WorldCard Contacts, only root categories will be imported. The subcat-
egories won't be imported. 

5.1.1 Categorize from Management Page

Each card, in addition to being categorized by last name, can also be categorized 
with our own individual settings so that you can efficiently manage numerous cards in 
your WorldCard database. From the WorldCard Management pane, highlight the card 
information you want to categorize, drag it directly into a specific category type under the 
Category list on the left side of the management window.
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5.1.2 Categorize from Editing Page

WorldCard allows you to categorize a business card directly from the Editing pane. To 
categorize a  card from the editing page, click on the Set Category  button . The Card 
Category dialog box appears. Select the category and then click OK. You may also add a 
subcategory from this window by clicking the Subcategory button.

5.1.3 Send Email by Category

To send email to a category group, select the appropriate category group from the 
management page. Once selected, the category will appear in the right pane of the 
Management window.

To send email to the group, click the Email button . WordCard will add the email 
addresses of the group members into your default email software. Also the Email editing 
window will then open with the appropriate contact list. 

Tips:

1. Cards in each category can be easily moved from one category to another by dragging.
2. Each card can belong to a main category and numerous sub-categories. For example, 

Bruce is a vendor of your company and your classmate. You can drag his card into ven-
dor category and then, drag his card into the classmate category from the All Records 
category. The first category you drag Bruce’s card to will become the main category for 
his card entry. 
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5.2 Merge and Separating Cards
 WorldCard allows you to merge two business cards into one card entry. To merge two 

cards into one, select two cards in the Management window.

On the Tool menu on the Editing window,  click Merge and the following dialog box 
appears.

Select the appropriate card as the front side of the merged card entry and press OK. This 
action will merge the cards into one entry.

Separating double-sided cards into two distinct card entries can also be accomplished 
with WorldCard. To separate a double-sided card into two separate entries, select the 
appropriate card from the Management window. Then, on the Tool menu click UnMerge. 
The double-side card is separated into two separate entries in the appropriate category.
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On the left side of the Editing window, the new colleague’s company information will 
appear in the Card Information pane of the Management window. You can scan or type 
your new contacts information into the field.

5.3 Add New Cards manually
You may add contacts to your WorldCard database by scanning their business card or by 

manually entering the contact information. If you do not have a card from a new contact, you 
can enter the contact information of a new business contact into your WorldCard database 
manually.

5.3.1 Add an Empty Card

To enter a contact manually without a business card, on the File menu in the 
Management window, click New Empty Card. This will open the Editing window.

In the Editing window, manually select each category for your new contact. Then, scan 
or type your new contacts information into the field.

5.3.2 Add the Same Company Card

WorldCard allows you to add contact information for a new colleague from a company 
that is already in your database without scanning the actual business card. To add a new 
colleague of a company already on file, in the Management window, select a card from the 
new colleague’s company.

After you have selected the card of the new colleague’s coworker, on the File menu in 
the Management window select the File\New Same Company Card. This will open the 
Editing window.
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5.4 Add Cards from Other Resources

5.4.1 Load Image File

Please click Run/ Images source/ Image  file, choose the recognition language and then  
pick up the business card images you want to recognize.

5.4.2 Twain Scanner

Card entries may also be uploaded through any TWAIN-compliant scanner. If your 
scanner is connected, WorldCard software will recognize it and add the scanner to the 
resource list. Click the Image Source arrow  and click Twain Scanner.

Ensure the resolution for your scanner is set to at least 300dpi and select a Twain device.

You may scan up to 8 cards at one time with an A4 size flatbed scanner. Place the card on 
the bed of your scanner with some separation between the card edges to clearly distinguish 
each individual card. You may also use an A4-size white paper to cover the business cards 
for recognizing regions of business cards properly.

When the scanning process is completed, the following TWAIN Scanner dialog box 
appears.
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5.4.3 Drag in the Signature Information

You can add the signature information to the contacts by selecting the signature or 
business card information in e-mail or a Word file. Then drag it directly to the WorldCard 
Management window. WorldCard will automatically add a contact and recognize the 
information into appropriate fields.

5.5 Deleting/Restoring Contacts
Right click on a contact and then select Delete from the pop-up menu or select a contact 

and then click Delete button , if you want to delete the selected contact.

Click Recycle Bin button  to view the contacts which have been deleted. You can 
delete the contacts permanently by clicking the Delete button or resotre the contacts by 
clicking the Restore button.

The system will identify the business 
card area automatically. Recognized cards 
will appear within red rectangular boxes 
with their corresponding recognition number 
superimposed in red. You can also click the 
Clear All Regions  button to identify 
the cards manually by drawing the business 
card area one by one.

Click the Auto Select Regions  
button can identifie the cards as in the 
previous display of the TWAIN Scanner 
dialog box.

After the cards have been identified, 
click Recognize. In the Language settings 
dialog box you can select the language to 
use to recognize the business cards. When 
the recognition process is completed, 
you will be returned to the Management 
window. Your new card entries appear at the 
bottom of the contacts.
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5.6 Search Contacts
 You can quickly and efficiently find your contacts with WorldCard Search features.

5.6.1 Text Search

The Text Search command of the WorldCard software allows you to quickly find a 
specific contact. To use Text Search in the WorldCard Management window, on the View 
menu point to Search, and click Text Search.

The Text Search pane appears as follows:

In the Text Search pane, enter a key word or a group of key words separated by a blank 
space in the Search box  and click the Search button    . 
The Search pane will update, displaying the results as in the following picture.

In the left pane, there is a list of all categories where the data from your search string was 
found. The right pane shows the search results that display all of the applicable fields for the 
cards stored in your WorldCard database.

You can double-click on any record displayed in the Search Results pane to open the 
card in the Editing window.

Tip: You may enter the Text Search win-
dow directly from the WorldCard 
Management window by clicking the 
Search button .



5-8 WorldCard

5.6.2 Advanced Search

WorldCard also offers an advanced 
search function. To use the advanced search 
function, on the View menu, point to Search 
and click Advanced Search.

The Advanced Search pane will open 
and appear as right.

Tip: You may also open the Advanced 
Search pane from the WorldCard 
Management window by clicking 
the Search button . When 
the Text Search pane appears, click 
on the Advanced Search button 

.

In the Advanced Search pane, you can enter your search criteria by category. You may 
select from categories in any one of three option windows. If you have several cards with 
similar criteria in your database, you may narrow your search further by using more than one 
of the Search Criteria menus.

Please also note that the Search Criteria options include the AND operator  and 
the OR operator . You may use these operators to further define your Advanced Search. 
The AND operator defines that your search results contain the criteria listed in all three 
search fields. Using the OR operator, a valid result must only match one of any of the three 
fields to be a valid result.

You can further define your Advance Search Criteria by using a specified Category. To 
select a specific category, select Select Category  and specify a category.

You may also define your Advanced Search by calendar dates. To define a period for an 
Advanced Search by Dates, select Select Dates icon  and make date selection 
available.

After a Category for your Advanced 
Search is selected from one or all three 
Category opt ions, you may enter an 
appropriate search string in the text field 
of each Category. A completed search will 
appear.
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5.6.3 Finding Duplicate Data

Over a period of time, you may find that you have received a business card from the same 
individual on more than one occasion.

WorldCard has a built-in feature for finding duplicate data. To use Finding Duplicate 
Data, click Run on the Main Menu and then Duplicates Data. A progress meter briefly 
displays in the middle of the Management window showing the progress of the search. 
After all records have been scanned, the Search Results pane displays the same display 
name entries as shown.

After selecting search by date, you may 
use the From and To date options to specify 
a period for your search criteria. The From 
and To options appear as in the right picture.

In the pane on the left side, there is a list of all Categories where Duplicates Data was 
found. In the Search Results pane on the right side, there is a list of all duplicate card 
entries.
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5.7 Safeguard your Contacts
Information is a valuable resource to any business. WorldCard recognizes the intangible 

value of your business card contacts and has built-in features to help you safeguard that data.

5.7.1 Save

WorldCard is a business card database management system. It automatically saves all 
changes when exit the system. You can manually save your card database by on the File 
menu click Save.

You can also save your database by clicking the Save button  on the WorldCard 
Management window.

5.7.2 Backup your contacts

You can save your database file to a specified directory for use as a backup file by using 
Save as. On the File menu, click Save As.

WorldCard database files are stored in the .wcf format. No other format options are 
available. After you have named your file accordingly, click Save to complete this operation.

5.7.3 File Encryption

Protecting sensitive contact information is important in the business environment. The 
WorldCard software recognizes the importance of sensitive data and allows you to protect 
that data from unauthorized access.

To protect your WorldCard database from unauthorized access, WorldCard offers you an 
automatic file encryption with password protection. You can encrypt your WorldCard data-
base by the following procedure.

On the File menu, click File encryption. 
The File encryption dialog box appears.

If you wish to use File encryption, 
select Use file encryption.
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With Use file encryption selected, you 
may use the File Encryption option with 
password protection.

When the Set Password/Change 
Password option is selected, the password 
option is available for you to enter your 
appropriate password options.

Note: Protect and safeguard your password. WorldCard does not offer a password recov-
ery option. If you forget your password, your database is inaccessible.

Tip: If you wish to decrypt the File encryption, place the mouse pointer over the selection 
circle of the UnUse file encryption option.
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5.8  Print Cards
WorldCard software allows you to print card information in several usable formats. An 

overview of the WorldCard printing features is presented in this chapter.

5.8.1 Print Preview

Before printing card information, WorldCard allows you to preview your information in 
the appropriate format for your desired output. To use the Print Preview options of your 
WorldCard software, on the File menu click Print Preview. and the Print Preview pane 
appears.

At the Print Preview pane, you can select several Print Preview Template Classes from 
the Template Class menu to the left of the Print preview pane.

After the applicable Template is selected, you may further define your printing preview 
by selecting the available options in the selected Template. A similar Print Preview option 
list will appear depending on your selected Template Class. 

When a Preview option has been selected, the Print Preview pane reflects that change 
on the right side.
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5.8.2 Edit Print Templates

WorldCard allows you to edit templates for printing your cards. On File menu click Print 
Template Edit, the following pane appears. You may also click the Edit Print Template 
icon .

To edit the Print Template, you may select a Template Class and Template from the left 
pane. Then adjust the settings of the print paper from the pane on the upper right. If you wish 
to choose print fields, you can drag the field into the template editing area.

Note: WorldCard’s attentive categorizing function makes it flexible on Editing Print Tem-
plates, such as you can add City, Zip Code under Address column

Note: You may also rename or delete templates with the Edit function.

WorldCard provides Add Label and 
Add List template model for creating your 
own templates. On the Template Class 
menu,  click Edit. The Edit dialog box 
appears.

To add a new print template, click Add 
Label or Add List, and then enter the 
template name. Click OK to return to the 
Print Template Edit pane for editing the 
new print template.
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5.9 Exchange Contacts
WorldCard software allows you to exchange valuable contact information with other ap-

plications through the use of the Import, Export and Synchronize commands.

5.9.1 Export

To select export fields, you may refer to 5.10.1 Export Option for a detailed explanation.

1. To export your WorldCard database to another application such as Microsoft Excel, 
Access, Outlook, Outlook Express, Lotus Notes, PocketPC, Palm, ACT!, Goldmine, 
Salesforce(Contacts), Salesforce(Leads), CSV, VCard, or WorldCard series, such as 
WorldCard Windows versions, WorldCard Mac version,  WorldCard Mobile versions ( 
WorldCard Mobile for iPhone and WorldCard Contacs for iPhone), on the File menu click 
Export. 
This will open the WorldCard Export Wizard screen and the following dialog box 
appears. For the supported software, please refer 5.9.4 WorldCard Data Exchange 
Compatibility List. Select the type of application for the file type that you want to create.

Tips: 

1. Export Text File allows you to export all 
fields.

2. Export function supports on Excel 97, 
Outlook 97 and Outlook Express 4.0 ver-
sion and higher.

3. Export Wizard will compress the file . It 
makes your filing and mailing easier by 
producing a smaller file.

Warnning: Because of the compliance between unicode and ANSI code, you might export 
unreadable characters to Palm Desktop, CSV or Vcard file in cases you ex-
portChinese, Japanese, Korean....from a single-byte language character based  
computer (such like English, German, French and so on) to a double-byte 
language character based computer (Such like Chinese, Japanese, Korean and 
so on).

2. Click Next. The next Export Wizard dialog box displays.
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4. If you have chosen to continue with the 
Export function, choose the directory to 
export the files to. Click OK to export 
the cards. To complete exporting the files, 
review the information displayed in the 
Export Wizard window.

5. After exporting is completed, click  
Finish to close the Export Wizard 
dialog box.

6. The Export Wizard operations for exporting your WorldCard database to all application 
types are similar and will not be discussed individually in this manual. However, a brief 
overview of the Export of a card to Microsoft Outlook will be presented.

3. Follow the instructions given in the 
Export Wizard dialog box to select 
which cards you want to export. And then 
click Next.
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2. On the File menu, click Export. The Export Wizard dialog box appears, as previously 
displayed in the section. Select the Microsoft Outlook application from the Application 
pane in Export Wizard dialog box and click Next. The next step is displayed in the 
Export Wizard dialog box.

3. Select Selected Cards in the Export Range. Click Next.
4. The following Export Wizard status dialog box appears.

5. When the Export process is  completed, you can view the Details page as shown in the 
following picture by clicking Detail.

To export a card to Microsoft Outlook:

1. select a card or a group of cards by selecting the specific card(s) in the WorldCard 
Management window as shown in the following picture.

Note: When exporting data to a Microsoft 
Office application such as Microsoft 
Outlook, you may receive a 
warning message to advise you 
that a program is trying to access 
email address information from the 
application. This warning message 
may appear similar to the following 
picture depending on your version of 
Microsoft Office. To continue, click 
Yes.
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6. From the Details dialog box, you can choose to export all details of each card or none. To 
close the Details dialog box, click OK. This will return you to the Export Wizard status 
dialog box as seen previously in this section.

7. To complete the Export process, click Accept. You may see a suspicious script warning 
message at this time. Click Continue on the warning dialog box to proceed. The  Export 
Wizard will now display the completed Status and Information of the exported cards 
being processed.. To exit the Export Wizard, click Finish.

Export contacts to other WorldCard Series products 
You need to export contacts from WorldCard first before you  share them. These contacts 

will be bundled and saved as .wcxf format, which can be shared by all WorldCard Series 
products via email or iTunes File Sharing. 

1. Select the contacts which you want to export. Click File\Export function from the menu. 
Select WorldCard Exchange File (.wcxf).

Notes

1. Only WorldCard Mobile 3.1.0 or later supports the .wcxf format.  
2. Only WorldCard Contacts 2.3.0 or later supports the .wcxf format.
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2. Follow the instructions given in the Export Wizard dialog box to select which cards you 
want to export. And then click Next.

4.  After exporting is completed, click Finish to close the Export Wizard dialog box.

3. If you have chosen to continue with the Export function, choose the directory to export 
the files to. Click OK to export the cards. To complete exporting the files, review the 
information displayed in the Export Wizard window.
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5. You can share the .wcxf contact file by attaching it to an email message and then share the 
.wcxf file with other WorldCard series prducts. 

         To share the .wcxf file with WorldCard(PC or Mac Version), please follow the steps   
below:

 
Step1  Open email with a .wcxf file. Then save the .wcxf file to your computer.

Step2  Lauch WorldCard.

Step3  Click the import button of on the toolbar. 

Step4  Select WorldCard series data exchange files and follow the  importing process to 
import the .wcxf file into WorldCard. 

Step1  Open email with a .wcxf file and 
tap the .wcxf file. Select Open In.

 Step2  Select the App that you want to 
share the .wcxf with. Then contacts in the 
app will open instantly and the contacts 
in the .wcxf file will be imported into the 
app at the same time.

To share the .wcxf file with WorldCard Mobile or WorldCard Contacts, please 
follow the steps below: 

Notes

Please open the .wcxf file with iPhone's built-in Mail application        .    
The .wcxf file cannot be opened in web-mail service.   
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6. You can share the .wcxf contact file by attaching it to an email message  or share the .wcxf 
file with WorldCard Mobile or WorldCard Contacts on your iPhone via iTunes File 
Sharing.

step 1  Connect your iPhone to your computer, launching iTunes on your computer,  and 
then selecting your iPhone from the Device section of iTunes

Notes

 iTunes File Sharing requires:
 1. iTunes version 9.1 or later. 
 2. Mac OS version 10.5.8 or later. 
 3. iPhone iOS version 4 or later. 

step 2  Select the Apps tab and scroll down to the bottom of the page. You will see the 
File Sharing section.

step 3  You will find a list of apps that 
are installed on your iPhone that supports 
File Sharing function. Select the app 
that you want to share the .wcxf contact 
file with. Take WorldCard Mobile 
for example. You will find the right 
Document area lists the file that can share 
with your computer.
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step 4  Please click Add... and  locate the .wcxf file that you want to copy from your 
computer and click Choose. This .wcxf file will be copied into the Documents sharing 
area immediately. 

step 5  Return to your iPhone. Choose  
WorldCard Mobile on your iPhone and 
select Settings\Import from iTunes file 
sharing. 

step 6  Tap .wcxf file that you want to 
import into WorldCard Mobile and then 
tap Import. The contacts in the .wcxf file 
will then be imported into Card Holer of 
WorldCard Mobile. 

 

Tip

You can click [Save to] to save the file in the Apps to your computer.
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5.9.2 Import

To import data into your WorldCard 
database from another application such 
as Microsoft Outlook, Outlook Express, 
P o ck e tP C , P a lm , A CT! , G o ldmin e , 
Salesforce(Contacts), CSV, VCard, World-
Card Mac, WorldCard Mobile for iPhone, 
WorldCard Contacts for iPhone, and etc:

1. Click Import on the File  menu. The 
Import Wizard dialog box appears.

2. Select the type of application source to 
import into your WorldCard database.

Note: The example displays import data 
from Microsoft Outlook Express us-
ing Windows XP.

3. Click Next in the Import Wizard dialog 
box. The next dialog box appears. For 
the supported software, please refer 
5.9.4 WorldCard Data Exchange 
Compatibility List.

Note: When importing data from a Mi-
crosoft Office application such as 
Microsoft Outlook, you may receive 
a warning message to advise you 
that a program is trying to access 
email address information from the 
application. This warning message 
may appear similar to the following 
picture depending on your version of 
Microsoft Office. To continue, click 
Yes.
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4. While your files are being imported, 
a blue progress bar displays. After 
the process is completed, the Import 
Wizard dialog box displays Status and 
Information.

5. You can view the actual information being imported by clicking Detail. The Details 
dialog box displays. In the Details dialog box, you can select to import all details of each 
card or none and then click the OK.

6. To complete the Import process, click Accept. The Import Wizard dialog box will update 
the Status and Information fields for the data accepted. When the update is completed, 
click Finish to close the Import Wizard. You will find that your imported records have 
been added to the bottom of the cards listed in All Records category.  
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Import contacts from other WorldCard Series products  

The new data exchanging function in WorldCard allows you to import contacts from 
another WorldCard series product, such as WorldCard Mobile for iPhone or WorldCard 
Contacts for iPhone. WorldCard will import the .wcxf file, whicn is compatible with all 
WorldCard Series products.

2. Click Browse to select a .wcxf file in your computer and click Next to continue the 
importing process. 

1. Click Import on the File menu. The 
Import Wizard dialog box appears. 
Select WorldCard Exchanged File.
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3. A note window will appear to ask whether you want to import category or not.  Click Yes 
to import categories or vice versa. 

5.  The new contacts should appear in the Browse pane.

4. Please click Finish to complete the importing process.
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5.9.3 Sync

The WorldCard Synchronize function allows you to synchronize the data between 
WorldCard and other applications such as Microsoft Outlook Express, Microsoft Out-
look, Lotus Notes, PocketPC Contacts, Palm Desktop, ACT! by Sage, Goldmine and 
Salesforce(Contacts).

1. To use the Synchronize function, on the File menu, click Sync. The Sync Wizard dialog 
box appears. For the supported software, please refer 5.9.4 WorldCard Data Exchange 
Compatibility List.

2. Select the application that you desire to synchronize with your WorldCard database by 
clicking Next. The Sync Wizard Status and Information dialog box will open. At the 
same time WorldCard will begin to synchronize with the selected application.

Note: If you are synchronizing with Outlook Exrpess and there are contacts whose name 
fields are empty, a message dialogue will pop up to warn you that those contacts 
will not be synched with. If you agree with it, then you can click Yes to continue the 
synchronization. 

Note: You can refer Secion 5.10.2 to adjust the setting of synchronization. 

3. While synchronization occurs, a blue progress bar displays. Once the process is 
completed, the Sync Wizard window will display Status and Information data about the 
records you have synchronize. In the Status pane you can see that there is a difference 
between the Microsoft Outlook database and the WorldCard database. The Information 
pane shows all actions that have been completed at this point.
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4. You can view the complete details of the actions that will be taken to synchronize the two 
databases from the Details dialog box. To view the Details dialog box, click Detail. The 
Details dialog box appears. From the Details dialog box, you can click Select all data to 
accept all data in the list as acceptable changes.

 
For this item, the Sync function would DELETE the entry from Microsoft Outlook. 
Alternatively, you can use the Select none data icon to clear the selection of all items in 
the list. After reviewing the Detail list, you may close the Detail window by clicking OK.

Note: When syncing data to Microsoft 
Office application such as Microsoft 
Outlook, you may receive a 
warning message to advise you 
that a program is trying to access 
email address information from the 
application. This warning message 
may appear similar to the following 
picture depending on your version of 
Microsoft Office. To continue, click 
Yes.
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Note: The Sync function synchronizes the Client database with the Host database. In 
other words, data in the Client database is changed to reflect the data in the Host 
database. After clicking Accept, the Client database is to match the Host database. 
After this point you cannot reverse the process. After you click Accept, a message 
window will pop up to ask you whether you are sure to synchronize now. If you are 
sure to synchronize now, please click Yes.

If you want to synchronize the contacts on both side but don't want to delete contacts, 
please click No to return to the Sync Wizard. In Sync Wizard, please click [Delete 
Sync record]. This will delete the previous synchronization record. Next time you 
synchronize, the existing data in WorldCard will be merged with the data in this 
application. It could result in duplicates. If you want to contiue, please click Yes. 
Otherwise, simply tap No to return to the Sync Wizard. 

Tip: You can refer Secion 5.6.3 to apply the Finding Duplicate Data function to remove 
the duplicates. 

5. To accept the actions required to synchronize the two databases, click Accept. The Details 
dialog box will display the updated Status and Information panes. To close the dialog 
box and complete the Sync process, click Exit.
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5.9.4 WorldCard Data Exchange Compatibility List

WorldCard supports the following synchronization, exporting, importing contact 
managers or personal information managers (PIMs).
WorldCard Synchronization

Item Windows
XP

Windows 7/
Vista 32

Windows 7/ 
Vista 64

Lotus Notes v6.5-v8.5 v v v
Microsoft Outlook v v v
Microsoft Outlook Express v
Microsoft Pocket PC Contacts 
(v3.x, v4.x and Mobile 5, 6)

v v

Palm Desktop v4.1.2 or later v v v
Salesforce v v v
ACT! 2007 or later 
(Standard/ Premium for Workgroups)

v v ACT! 2009 or 
later

Goldmine v6.50 v

WorldCard Export
Item Windows

XP
Windows 7/

Vista 32
Windows 7/

Vista 64
Lotus Notes v6.5-v8.5 v v v
Microsoft Outlook v v v
Microsoft Outlook Express v
Microsoft Pocket PC Contacts 
(v3.x, v4.x and Mobile 5, 6)

v v

Palm Desktop v4.1.2 or later v v v
Salesforce v v v
ACT! 2007 or later 
(Standard/ Premium for Workgroups)

v v ACT! 2009 
or later

Goldmine v6.50 v
Time & Chaos v v v
CSV (Comma Separated Text File) v v v
Image (Jpg) v v v
Microsoft Access File v v v
Microsoft Excel File v v v
Microsoft Windows Contacts v v
Text File v v v
VCard File v v v
WorldCard File (v6.0 or later) v v v
WorldCard Exchange File (.wcxf) v v v
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WorldCard Import

Import contact data from the following products to WorldCard:
Item Windows

XP
Windows 7/ 

Vista 32
Windows 7/ 

Vista 64
Lotus Notes v6.5-v8.5 v v v
Microsoft Outlook v v v
Microsoft Outlook Express v
Microsoft Pocket PC Contacts 
(v3.x, v4.x and Mobile 5, 6)

v v

Palm Desktop v4.1.2 or later v v v
Salesforce v v v
ACT! 2007 or later 
(Standard/ Premium for Workgroups)

v v ACT! 2009 or 
later

Goldmine v6.50 v
Time & Chaos v v v
CSV (Comma Separated Text File) v v v
VCard File v v v
WorldCard File (v5.0 or later) v v v
WorldCard Exchange File (.wcxf) v v v
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5.10 Settings
WorldCard has many selectable Setting options to allow you to configure the operational 

functions of Export, Synchronize, Field Display, User Define Field, Scan and Personal 
setting options. To set your WorldCard options, use the procedures outlined in this chapter.

On the Tool menu, point to Setting and click any of the options. Alternatively, on the 
main toolbar click the Setting button .

5.10.1 Export Option

To configure the Export options, open 
the Setting dialog box page as described in 
the preceding section of this chapter.

The Setting Export dialog box displays 
with ALL options selected as a default con-
figuration. The fields on the right will be ex-
ported to Excel, Access, CSV files and  Text 
file. To add another field, select a field from 
the left side and click the [->] button. Click 
[>>] button to export all fields. You can set 
the number of fields with the same name to 
export (up to 10 ). 

Select Split address field to export ad-
dress detail to different fields. After you’ve 
selected the options you want, click OK to 
accept the changes. 
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5.10.2 Synchronize Option

To set the Synchronize options, open the 
Setting dialog box as described in the pre-
ceding section of this chapter.

The Synchronize tab of the Setting 
dialog box appears with Microsoft Outlook 
as the selected PIM. PIM  stands for Pro-
tocol Information Management software. 
Change the PIM as desired. The Conflict 
Process option can be set to manage any 
conflicts which may occur during the Sync 
operation.

Under Select PIM software, you will 
find Field Accordance. You may click 

 to set the field accordance between 
WorldCard and PIM software for importing, 
exporting and synchronizing.

Note: Conflict means after previous Synchronization, the contact information has been 
changed in both PIM software and WorldCard which causes Conflict.

ACT! and Goldmine require a user ID, 
Password and DB Path. Before synchroniz-
ing with above applications, you may input 
this information into the boxes in the Other 
Options area.

Salesforce requires a user ID, Password 
and Security Token. Before synchronizing 
with above applications, you may input this 
information into the boxes in the Other Op-
tions area.
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5.10.3 Field Display

To set the Field Display options of the 
List Mode and Duel mode, open the Setting 
dialog box as described in the preceding 
section of this chapter.

The Field Display tab of the Setting dia-
log box appears with a default configuration 
as displayed in the above window. To mod-
ify the selected options, click any available 
field  from the Available Field menu on the 
left side of the dialog box. After a field is se-
lected, click Add to add it to the Displayed 
Field list. The selected field will be added to 
the applicable WorldCard screens.

To remove a field, click the desired field in the Displayed Field list. Then click Remove 
to delete the field from your WorldCard screen views. You may also set field options from 
the available options on the right side of the Field Display window. Once you have com-
pleted your changes, click Apply to apply any changes.

The Alphabet index can be indexed by Display Name or by Company. Please refer to 
Chapter 3.1.

5.10.4 User Define Field

To configure the User Defined Field options, open the Setting dialog box as described in 
the preceding section of this chapter.

The User Defined Field tab displays 
the default configuration as seen in the 
preceding picture. You may define up to 
ten user-specified fields to be displayed in 
your WorldCard screens. To define a field, 
select a User Defined Field from the avail-
able fields on the left side of the dialog box. 
Then, assign the Defined Field Name and 
Define a Recognition Keyword in the text 
box. Set the language recognition option 
and click Apply.
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5.10.5 Recognition Option

To configure the Recognition options, open the Setting dialog box as described in the 
preceding section of this chapter.

The Recognition tab displays the default 
configuration as seen in the preceding 
picture. You may define Language, Chinese 
character options and Name display 
method. 

Check Capitalize the first letter of 
name to recognize the first letter of the 
contact's name to a capital letter. The other 
letters of the name will be recognized to 
lowercase letters.

After recognizing Chinese business 
cards, you can choose Output character to 
save them as the characters which you are 
familiar with. Such as Traditional Chinese 
or Simplified Chinese.

WorldCard software has optical character recognition (OCR) capabilities designed to 
work specifically with Chinese characters.

Under the Chinese character option area, you  can select Recognize Hong Kong 
characters if you are scanning cards from Hong Kong. The character set for Hong Kong is 
slightly different than the Traditional or Simplified Chinese character sets.
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5.10.6 Personal Setting

The Personal Setting can let you setup your presonal inforamtion, notify contacts, set 
notice contacts and set the start address of the direction function. To setup the Personal 
Setting options, open the Setting dialog box, and then click the Personal Setting tab.

Personal Information

Click the Personal Information button to input General Information, Office information 
and Home inforamtion. You can fill the information by typing your own business card 
information.
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Notify Immediately

After setting your presonal information, you can notify related contacts immediately. 
Click the Notify Immediately button to send your presonal information with VCard and 
html  file by the default email application.

If you set the notice contacts already, the system will add the email addresses of the 
contacts to the receivers.

Set the Notice Contacts

Click the Set the Notice Contacts button to select the contacts which you want to notify  
your presonal information. When you click the Notify Immediately button, the system will 
add the email addresses of the selected contacts to the receivers.
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5.11 Online Map
WorldCard offers you online map with a click of your mouse.

2. You can also right-click on the contact, then click Display map of Address. 

3. If address searching you selected is more 
than one contact, the Display map of 
Address menu will appear. Click on the 
address you want search will lead you to 
online map automatically.

1. Select the contact, then click Run / Display map of Address. 
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5.12 Getting Direction
WorldCard provides Get Direction function through internet service websites for looking 

up the route between two contacts or between your location and a specific contact.

1. Right click on a contact and select Get direction/Direction from here from the pop-up 
menu.

Tip: If you want to set your address as the start location, you can preset your address in 
the Personal Settings and skip step 1. Please refer to 5.10.7 Personal Setting for 
details.

2. Right click on another contact and select Get direction/Direction to here.

3. After setting the Direction from here and Direction to here, a Get Direction window 
will pop up. You can select the start location or destination to your personal address.

Tip: If the contact you selected has more than two addresses, you can choose an address 
by clicking the pull-down menu.
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5.13 WorldCard Portable Disk
With Penpower WorldCard, you have a new traveling companion and all the flexibility 

you need for a successful business trip. You can quickly store your WorldCard Portable soft-
ware and database on any USB flash disk and access them from the USB port of any avail-
able computer.

5.13.1 Saving Card Data to a Portable Disk

Note: WorldCard does not provide a flash disk.

To save your WorldCard database to a portable disk, at the Management window click 
the Export to Flash Disk button . The Flash Disk dialog box displays.

In the Flash Disk dialog box, select an 
Export Range. Setting the range to the Se-
lected Cards option exports only the cards 
that have been selected in the Management 
window.

After you have set the Export Range, 
select a Flash Disk drive from the Select 
Drive list for available flash drives on your 
system. After you have selected the correct 
flash disk drive, click OK.
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5.13.2 Card Data Management for Portable Disk

To use the card data stored on a flash disk, plug the flash disk into the USB port of any 
computer. Using the My Computer directory of Microsoft Windows, locate the Flash Disk.

In the flash disk directory, locate the Card_MiniDrv folder. Double-click the Card_
MiniDrv folder. The following directory appears.

Double-click on the WorldCard_M application as highlighted in the above. WorldCard 
will display the MiniDrvWCard.wcf Read only mode as shown in the picture below.

In the Mini_Drv mode you can view cards in List , Label, Image or Dual mode. You 
can use WorldCard search functions and send email using the same procedures as the 
standard WorldCard database in the office. For instructions on using any of these available 
features, see the previous sections of this manual for complete operational instructions.



FAQ

FAQ
Q: How can I convert the files in earlier version to v6.X format?
A: WorldCard v6.x can convert your v5.x version files and import them in v6.x format. (For 

v3.0, v4.0 CRD format, support is not available at this moment.) On the File menu, click 
Import and then WorldCard file to convert the files to v6.x format. You can also use the 
Start-Up Wizard to accomplish this task.

Q: Why are there dark lines on the scanned pictures of business cards, or all scanned 
pictures turn out blank?

A: Scanner occasionallly needs calibration to perform at its best. If the scans are showing 
lines or black dots, please calibrate your scanner. Please turn on the scanner and insert the 
calibration sheet (provided by Penpower) to start automatic calibration.

Q: How do I backup business card files?
A: On the File menu, click Export and click WorldCard files (v6.0 or later) to back up 

files.

Q: How can I protect my business card files from being opened by other persons with-
out my permission?

A: On the File menu, click File encryption to encrypt files. Other persons have to type in 
your predefined password to open the encrypted files.

Q: How do I combine two pieces of business card data into one?
A: Hold down CTRL and click the left mouse button to select two single-sided business card 

picture files or the image-less data of the card. Then right-click, click Combine, and set 
either one to be the front side of the data combined.

Q: How do I separate a single picture file with data including the business card infor-
mation of front and rear sides into two separate data files?

A: Select the data including the business card information of front and rear sides, right-click, 
then click UnMerge.

Q: How do I add the signature information in e-mails to the business card files?
A: Select the signature or business card information in e-mail or a Word file. Then drag it 

directly to the main management window to add a contact.
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